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1 THE APPLICATION INTERFACE

1 The Application Interface

TopoView is a Membrane Protein topology viewer, mainly developed to display specific
structural features of membrane proteins, such as interface helices, “disrupted’ﬂ transmem-
brane helices or non contacting consecutive helices. Examples of all these structurally special
motifs are given in the next section. This section is an introduction to the usage of the tool

“TopoView”.
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File  Options Help

=

Cytoplasm

Periplasm

Figure 1: The application window

TopoView consists of two different windows, one for displaying the topology and one for the
creation of this topology. Figure [I] shows the main application window. It is divided in two
parts, the menu bar, where the user can handle the basic procedures and the representa-
tion panel, where the actual topology images resides.

!One long transmembrane helix is “broken” in two short ones, lying above of each other.
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1.1 The Menu Bar

The menu bar is always visible and is composed of three main control menus:

e The File menu

Create topology

Before the topology can be displayed, the user must create it using the “creation
window” (figure . So by choosing the option “Create topology”, the creation win-
dow appears.

— Load topology
Here, the user is able to upload a topology file. An example for such a file can be

found in the appendix

— Load TMX prediction
Here, the user is able to upload a TMX prediction provided by the TMX server
(http://service.bioinformatik.uni-saarland.de/tmx/). An example for such a file

can be found in the appendix [A.4]

— Export image
After creation of a topology, the image can be exported with this option as a
printer-friendly version (png (portable network graphic), resolution 1000 x 1000
pixels, white background).

— Export highquality image
This option is for exporting the topology as a highquality image with a resolution
of 1800 x 1800 pixels.

e The Option menu

— Zoom in
Here, the image is increased by 100%, so that details can be investigated.

— Zoom out
By activating this button the general view of the image is shown.

— Mark non contact
If the user has specified a non contact in the creation window, the non contacting
helix pair is not shown until this button is pressed (see “Example” section).
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— Unmark non contact
Here, it is possible to unmark the non contact, so that the original image appears
again.

e The Helical wheels menu

— Property coloring
The amino acids of the helical wheels are colored accordingly to their property
(small, acidic, polar, ...).

— TMX coloring
The amino acids of the helical wheels are colored accordingly to their predicted ex-
posedness. Before this option is possible a TMX prediction must be uploaded
in the “File” menu.

— Conservation coloring
The amino acids of the helical wheels are colored accordingly to their conservation.
Before this option is possible a TMX prediction [A.4 must be uploaded in the “File”

menu.

e The Help menu

— About
The “About” option contains information about the author and the version of the
tool.

— Help
Here, the user gets help through a direct link to the user’s manual.
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1.2 The Creation Window

Protein name:

Create Topology

g
A

Sequence in fasta format:

Open .fasta file

B

Long TM Helices (ldenifier Startresidue Endresidue):

AN
i

7]

Browse ... |

D

Open TMHMMZ.0 file

Short TM Helices (ldenifier Startresidue Endresidue):

_
!

Browse ... |

;

F

Interface TM Helices (ldenifier Startresidue Endresidue):

Il

G

Reentrant. Loops (Helix1 Helix2):

Il

~» Periplasm
v Cytoplasm

H

Long non contacting consecutive Helices:

Helix 11D: | Helix 2 ID: | |

Position of the H-terminus (if available):

J

=

CreatelK

Figure 2: The creation window

A Input box for an abitrary protein name (optional). If a fasta file containing a protein name
is loaded up (see C), this protein name is then adopted here.

B Input field for pasting in an amino acid sequence in fasta format (required).

C By pressing this button a File-Dialog window appears and the user is able to upload a fasta
file (see appendix for an example file). This sequence is then displayed in B.

D In this input box the user must define the transmembrane segments (required). This is done
by specifying the start- and end-residue of each transmembrane helix. First the helix
should get an ID (unique integer), after a space the index of the start-residue should
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follow and at last the index of the end-residue (e.g. 1 35 50). For each helix a new
line should be used. The user has to take some care in specifying this transmembrane
segments: helix IDs must be unique and integers, the index of the start-residue must be
smaller than the index of the end-residue and the helix must be at least 15 residues long.

E By pressing this button a File-Dialog window appears and the user is able to upload a
output file from the TMHMM 2.0 serverﬂ (for examples see appendix [A.2). The trans-
membrane segments specified in this file are then displayed in D.

F Input field for specifying short transmembrane helices (optional). In some membrane pro-
teins “broken” helices appear, which are short transmembrane helices lying above of each
other and are connected by a very short loop ( < 5 residues). Here, the user is able to
specify such a kind of structural anomaly. The input is carried out by the same scheme
as for the long transmembrane helices in D (unique-Helix-1D start-residue end-residue).
Here, the user has to take care again. When using this option, always a pair of short
helices must be specified.

G This input box allows the user to define interface helices (same scheme as explained above
(D)) (optional). Interface helices often appear in transmembrane proteins and lie nearly
parallel to the lipid bilayer. They are mostly only five to ten residues long.

H Here, the user is able to specify reentrant loops between two helices (optional). Reentrant
loops are membrane penetrating regions that enter and exit the membrane on the same
side. The user has to declare the IDs of the two consecutive transmembrane helices
between which the reentrant loop lies (Helix-1-ID Helix-2-ID). The user has to take care
that the two helices are already specified before.

| In this part the user can declare two consecutive long transmembrane helices that have no
interaction in the folded 3D structure (optional). The IDs of the two helices must be
declared in the two input boxes (caution: the IDs must be defined before and the IDs
must be consecutive).

J If the location of the N-terminus of the membrane protein is available, the user can specify
it here (optional). The default is “cytoplasm”, since the N-terminus of most membrane
proteins is located there.

K When this button is activated “TopoView” controls whether all inputs are correct and do
not break the rules. In the case an input is wrong a message-box opens and informs the
user about the mistake and the changes that have to be made. If all inputs are correct
“TopoView” starts to calculate the topology image, as soon as the calculation finished
the image is displayed in the representation panel.

?Transmembrane protein topology server. http://www.cbs.dtu.dk/services/ TMHMM/
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2 Usage of TopoView

2.1 A simple example

After starting TopoView, the option “Create topology” in the “File” menu has to be chosen.
The creation window appears where one can upload a fasta file and a TMHMM 2.0 output
file. Figure [3| shows the input in the creation window on the left side the result of this input
on the right side.

Protein name: 1BCC chain ©
File Options Help
Sequence in fasta format:
MAPNIRESHPLLKMINNSLIDLPAPSNISAWWNF GSLLAVOLIT ILTOL
LLAMHYTADTSLAFSSVAHTCRNV(Y GWL IRNLHANGASFFF ICIFLHL
GROLTYGSYLYEETWNTGVILLLTLMATAFVGYVLEWGOMSFWEATVITN
LFSATPYIGHTLVEWAWOGE SVONPTLTRFF ALHFLLPFATAGITI THL
Open .fasta file Browse ...
Long TM Helices (ldenifier Startresidue Endresidue):
1 4 56
2 a3 105
3 17 139 op
Open TMHMMZ.0 file Browse ...
Short TM Helices (ldenifier Startresidue Endresidue): KeCes 2, . LK
g S -5 \ . SSPIVIL
,‘ " * ’ X .“ 1 b D\‘)(-"r/
* * v W %y oo
( s ' A 2 ‘ ",§ * e
RARRENY B R J ol @) B
Interface TM Helices (ldenifier Startresidue Endresidue ): 532922082 . e, < ‘ L A e >
y ) *a [ .
R < BN
Reentrant Loops (Helix1 Helix2): Pe
Long non contacting consecutive Helices:
Helix 1 1D: Helix 2 1D:
Position of the N-terminus (if available):
Periplasm
Cyloplasm Create

Figure 3: Example input and its result. Loops, that are too long, appear as globular domains
(blue spheres).

Then we can use the “Option” menu and the option “Zoom in” to increase our topology image
by 100%. The result of this is illustrated in figure

If we are satisfied with our topology image, we can choose the option “Export image (png)” in
the “File” menu to save the image as a printer-friendly version. The result of the export can
be seen in figure
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Figure 4: Result of the option "Zoom in’.
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Figure 5: Export of topology image as png with a resolution of 1000 x 1000 pixels.
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2.2 Example: Creating short transmembrane helices

In this example we use additionally the option to create two short transmembrane helices.
Therefore we define a pair of short transmembrane helices in the corresponding input field of
the creation window. Figure [6] shows the input on the left side and its result on the right side.

ate Topology

Protein name: 1BCC chain o

Sequence in fasta format: File  Options

MAPNTRE SHPLLEMINNSL IDLEAPSNI SAWWNE G SLLAVCLMTOILTGL
LLAMHYTADTSLAF S SWAHTCRNV (Y GWLIENLHANGASFFF ICTFLHT
GRAELYYGSYLYRETWNTGVILLLTLMATAF VGTVLPWGOMSFWEATVITH
LFSAIPTIGHTLVEWAWGCF SVONPTLTRFFALIFLLPFATAGITITHL

Open .fasta file Browse ...

Long TM Helices (ldenifier Startresidue Endresidue):

5 179 201

3 230 252
7 280 308

Cytoplasm
Open TMHMMZ .0 file Browse ...

Short T M Helices~{ldenifier Startresidue Endresidue):

v

10 260 267
11 270 2794

Interiaen Th MaliCes (ldenifier Startresidue Endresidue):

Reentrant Loops (Helix1 Helix2): Periplasm

Long noh contacting consecutive Helices:

Helix 1 ID: Helix 2 ID:

Position of the N-terminus (if available):

# Penplasm
Cyloplasm Create

Figure 6: Example: Creating short transmembrane helices (Helix 10 and 11).
It must be pointed out:

e The helix IDs must be unique consecutive integers.

e The index of the start-residue of the helix must be smaller than the index of the end-
residue.

e The loop between the helices should not be longer than 5 residues, since this leads to
an unrealistic representation.
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2.3 Example: Creating interface helices

Here, it is shown how to construct interface helices by the appropriate input box in the cre-
ation window. In the figure below the sample input is illustrated on the left and its result on
the right.

Protein name: 1BCC chainc

File Options

Sequence in fasta format:

MAPNTRK.SHPLLEMINNSLIDLPAPSNI SAWWNE GSLLAVCLMTO ILTGL
LLAMHYTANTSLAFS SYAHTCRNYOY GWLIRNLHANGASFFFICIFLET
GRGLYYGSYLYKETWNTGVILLLTLMATAF VG YVLPWGOMSFWGATVITN
LFSAIPYIGHTLVEWAWGGF SVONPTLTRFFALHFLLPFATIAGITITIHL

Open .fasta file Browse ...

Long TH Helices (ldenifier Startresidue Endresidue):

1 Ex 3

2 a3 105

3 117 120

Open TMHMMZ.0 file Browse ... | [RB AN EEE]

Short THM Helices (ldenifier Startresidue Endresidue):

Interface TM Helices (ldenifier Startresidue Endresidue):

o
110 260 27q

Reentrant Loops (Helix1 Helix2): Periplasm

Long non contacting consecutive Helices:

Helix 1 1D: Helix 2 1D:

Position of the H-terminus (if available):

# Periplasm

Cytoplasm Create

Figure 7: Example: Creating an interface helix (Helix 10).

It must be pointed out:

e The helix ID must be a unique integer.

e The index of the start-residue of the helix must be smaller than the index of the end-
residue.

10
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2.4 Example: Creating reentrant loops

In this example we construct a reentrant loop by specifying the two consecutive helices that
are neighbours of the reentrant loop. Figure [§] shows the input on the left side and again on
the right side the result can be seen.

Protein name: 1BCC chain c
File Options
Sequence in fasta format:

MAPNTRESHPLLEMINNSLIDLPAPSNISAWWNE G SLLAVCLMTOILTGL
LLAMHYTADTSLAF S SWAHTCRNVOY GWL IRNLHANGASFFF ICIFLHT
GRGLYYGSYLYKETWNTGVILLLTLMATAFVGYVLPWGOMSFWOATVITH
LFSATPYIGHTLYEWAWGGF SVONPTLTRFFALHFLLPFATAGITITHL

Open .Tasta file Browse ...

Long TM Helices (ldenifier Startresidue Endresidue):

1 34 56
z a3 105

£l 7 133 Cytoplasm
Open TMHMM2.0 file Browse ...

Short TM Helices (ldenifier Startresidue Endresidue):

Interface THM Helices (ldenifier Startresidue Endresidue):

Periplasm

Reentrant Loops (Helix1 HelixZ):

BE)
= -

Long noh contacting consecutive Helices:

Heliz 1 1D: Helix 2 1D:

Position of the N-terminus (it available):

Periplasm

# Cyloplasm Create

Figure 8: Example: Creating a reentrant loop between helix 2 and 3.

It must be pointed out:

e The helix IDs must be defined before and must be consecutive.

e The length of the reentrant loop should not exceed 20 residues, since this leads to an
unrealistic representation. The minimum loop length is 10 residues.

e A reentrant loop between two short transmembrane helices (see above) is not possible.

11
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2.5 Example: Creating consecutive non interacting helices

This example shows how a non contact is assembled. We use the input boxes for the non
contact at the bottom of the creation window. Here, we fill in the two IDs of the consecutive
helices that should have no interaction. After the topology image has appeared, we use the
option “Mark non contact” in the “Option” menu (see ﬁgure@. The result of the sample input
is shown in figure [10]

Protein name: 1BCC chain c

Sequence in fasta format:
Zoom in

MAPNTRESHPLLENTNNSL TILPAP SNTSAVVNF GALLAVCLITATLTOL | % 2G0T 0T
LLAMHYTADTSLAF 55VAHTCENVOYGVL IRNLHANGASFFFICIFLHI || I O CONACL
|GRCLYY0SYLYRETWNTGY ILLLTLMATAF E¥VLPWE QMSFYGATYITH e
LFSATPYIGHTLVEWAVGGF SVONPTLTRFFALHFLLPFATAGITIIHL | /

Open .fasta file Browse ... |

Long TM Helices {ldenifier Startresidue Endresidue):

M 44 166
5 178 201 3

3 230 252 Cytoplasm
Open TMHMMZ.0 file Browse ... | |

Short TM Helices (ldenifier Startresidue Endresidue):

Interface TM Helices (ldenifier Startresidue Endresidue):

Periplasm

Reentrant Loops (Helix1 Helix2):

Long non contacting consecutive Helices:

"Helix 1 1D: [5 Helix 2 1D:

Position of the N-terminus (It available):

# Periplasm

Cytoplasm Create

Figure 9: Example: Creating non interacting consecutive helices (helix 5 and 6).

It must be pointed out:

e The helix IDs must be defined before and must be consecutive.

e The loop between the non contact must be at least 10 residues long and the loop of the
neighboring helix which is permuted to constitute the non contact must also be at least
10 residues long.

e If a non contact and a reentrant loop are between the same two helices, the helices will

12
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not be permuted but highlighted in green.

e The non contact is only possible between long transmembrane helices. Also at least
one neighbor of these helices should be a long transmembrane helix, otherwise it is not
possible to shift the helices and they will only be highlighted in green.

Fle Options

Cytoplasﬁ\

Periplasm

Figure 10: Result of creating non interacting consecutive helices (helix 5 and 6).

13
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2.6 Example: Creating helical wheels

It is also possible to create helical wheels with TopoView. After a topology is created we can
get helical wheels of all TM helices in the “Helical wheels” menu. Here it is possible to choose
between three different coloring modes of the amino acids (property, exposedness (TMX) and
conservation), whereas the last to modes are only available if a TMX predition is uploaded
in the “File” menu before. Examples for the three different coloring modes are shown in the
figures below.

Property coloring

Smal | Hydophobic | Por  |Polscaronat [BSSER IR
Expurtl < | Heliz Wheel 2 E3S | Quit |

Figure 11: Result of creating a helical wheel with property coloring.

14
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1541

Leiawn

16GW

Export £33 Helix Wheel 4

Figure 12: Result of creating a helical wheel with TMX coloring (predicted exposedness).

onservation coloring

Export £33 Helix Wheel 1 £ Quit

Figure 13: Result of creating a helical wheel with conservation coloring.

15



A INPUT FILE EXAMPLES

A Input File examples

A.1 Fasta file

>1BCC chain ¢
MAPNIRKSHPLLKMINNSLIDLPAPSNISAWWNFGSLLAVCLMTQILTGLLLAMHYTADTSLAFS
SVAHTCRNVQYGWLIRNLHANGASFFFICIFLHIGRGLYYGSYLYKETWNTGVILLLTLMATAFV
GYVLPWGQMSFWGATVIT. ..

Figure 14: Example for a fasta file. The first line, beginning with the greater-than sign contains the
protein name. The following lines are reserved for the amino acid sequence in upper letter
code.

A.2 TMHMM 2.0 file

Sequence len=380 ExpAA=193.88 First60=22.59 PredHel=9
Topology=134-56083-1051117-1390144-1661179-2010230-2521289-3080323-3411348-3700

Figure 15: Example for a TMHMM 2.0 output file (one line per protein).

# Sequence Length: 380

# Sequence Number of predicted TMHs: 9

# Sequence Exp number of AAs in TMHs: 193.8761
# Sequence Exp number, first 60 AAs: 22.58622
# Sequence Total prob of N-in: 0.73570

# Sequence POSSIBLE N-term signal sequence
Sequence TMHMM2.0 inside 1 33
Sequence TMHMM2.0 TMhelix 34 56
Sequence TMHMM2.0 outside 57 82
Sequence TMHMM2. 0 TMhelix 83 105
Sequence TMHMM2 .0 inside 106 116
Sequence TMHMM2. 0 TMhelix 117 139
Sequence TMHMM2.0 outside 140 143
Sequence TMHMM2. 0 TMhelix 144 166

Figure 16: Example for a TMHMM 2.0 output file (extensive, no graphics).

16
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A.3 Topology file

name: 1BCC chain c

sequence

>>
MAPNIRKSHPLLKMINNSLIDLPAPSNISAWWNFGSLLAVCLMTQILTG
LLLAMHYTADTSLAFSSVAHTCRNVQYGWLIRNLHANGASFFFICIFLH
IGRGLYYGSYLYKETWNTGVILLLTLMATAFVGYVLPWGQMSFWGATVI
TNLFSAIPYIGHTLVEWAWGGFSVDNPTLTRFFALHFLLPFATAGITII
HLTFLHESGSNNPLGISSDSDKIPFHPYYSFKDILGLTLMLTPFLTLAL
FSPNLLGDPENFTPANPLVTPPHIKPEWYFLFAYAILRSIPNKLGGVLA
LAASVLILFLIPFLHKSKQRTMTFRPLSQTLFWLLVANLLILTWIGSQP
VEHPFIIIGQMASLSYFTILLILFPTIGTLENKMLNY

>>

N-terminus: cytoplasm
™ 2 33 54
™ 4 7 104
™ 5 111 129
™ 8 173 203
™ 9 224 246
™ 12 320 341
™ 13 346 377

sTM 10 273 283
sTM 11 288 304

IH 1 11 16
IH 3 62 73
IH 6 138 149
IH 7 158 165
RL 8 9
NC 8 9

Figure 17: Example for a topology file.

In the first line the name of the protein is written (required). The second and the third line
mark the beginning of the amino acid sequence (required). Then the amino acid sequence in
upper letter code follows (required). The sign “»” marks the end of the sequence (required).
The next line holds the “N-terminus” of the protein, if not known, please write: “N-terminus:
noinfo” (required). The lines starting with “T'M” hold the borders of transmembrane segments
(required). First there must be a unique integer and then the start and the end residue of the
transmembrane helix (start residue < end residue). The lines starting with “sTM” represent
the short transmembrane helices that are lying above of each other, therefore always a pair is
necessary (optional). Here, there must be also a unique integer first and then the start and the
end residue of the transmembrane helix. The loop between the two short helices should not
exceed 4 residues. Lines with “IH” at the beginning represent the interface helices (optional).
Here also the same principle as above holds (unique integer startresidue endresidue). The “RL”
represent reentrant loops (optional). Here two helix IDs, specifyied before, are necessary. The
loop must have a minimum length of 10 residues. The last structure that is possible is that of
non interacting consecutive loops “NC” (optional). Only one non contact is possible and the
two helix IDs of the helices that should have no contact are required.

17
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A.4 TMX prediction file

Calling predictor for MSA : lbcc_cclustalw.aln
Frequency profile prepared.
Sequence Submitted: MAPNIRKSHPLLKMINNSLIDLPAPSNISAWWNFG. ..

Aligned Sequence: MAPNIRKSHPLLKMINNSLIDLPAPSNISAWWNEG. ..

Starting at 0

Length of Sequence 380

Predictions sorted by AA

typeAmino Acid Count Average Confidence Score Average Conservation Index

TRP 11 0.61 0.83
PHE 29 0.79 -0.17
TYR 13 1.13 0.74
MET 10 1.44 -0.06
LEU 63 1.54 -1.13
ILE 33 1.55 -0.30
VAL 14 0.57 0.54
ALA 27 0.86 -0.04
CYS 3 1.11 1.07

Total Residues Exposed: 193( 50.92)
Total Residues Buried: 186( 49.08)

Summary of Prediction resultsTemp
Protein TempChain TempIndex Residue Conservation Positionalscore Predicted Confidencescore

1bc A 0 M 0.86 0.10 E 0.10
1bc A 1 A 0.32 0.10 B 0.10
1bc A 2 P 0.39 0.04 B 0.04
1bc A 3 N 0.53 0.10 E 0.10
1bc A 4 I 0.15 0.20 E 0.20
1bc A 5 R 0.92 0.03 B 0.03
1bc A 6 K 0.86 0.06 B 0.06

Figure 18: Example for a TMX prediction file (input: Multiple sequence alignment).

18
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